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1 Critical info
All files listed below are due April 12, 8AM

• TRC files for each trial/subject to be used in OpenSim - Upload to Box

• GRF files for each trial/subject to be used in OpenSim - Upload to Box

2 Introduction
For this project, you will collect video-based motion data of the conditions outlined in your proposal. Each team
member will be a subject in your experiment. We recommend collecting multiple videos (trials) for each subject
so that you can pick the "best" video per subject. Best is defined as a trial where all the markers are visible during
the stance phase of your activity. You will be required to process one trial per subject.

3 Main Tasks
1. Determine needed materials for your project. Ensure that all subjects have access to all materials (weighted

backpacks, shoe types, etc).

2. Coordinate amongst your team members collecting video data. You will need video from both the left and
right. Ideally this would be done at the same time, but you may collect the data separately if this isn’t
possible. If you record data separately, use a metronome or a musical beat to set the pace of gait (there
are many free "metronome" apps available for phones).

3. For each subject, record at least 3 videos of them performing the task.

4. Using the steps below, post-process your kinematic data. Select a sampling frequency that is consistent for
all trials.

4 Experimental data collection
1. Attach bright markers on your shoulder, hip, knee, ankle and toe on the lateral sides of your body.

Important: Attach markers on the skin whenever possible. Attaching markers on top of your clothing can
cause markers to move during motion and make your data very noisy. Images below with markers on the
clothes are for illustration purposes only.

2. Place phone/camera such that each camera records one side (left/right). Before recording your video, make
sure your whole gait cycle can be recorded without moving the camera. Camera should always be FIXED.
One gait cycle is defined as one heel strike to another. Remember to place a ruler/calibration object in the
field of view.



Caution: Make sure you are using a using the same reference for calibration on both videos. If you use
different references your motion data will be off.

3. Follow the instructions from Tracker Quick Start to calibrate your video by entering the length of the scale
you used.

4. Open the video for either right or left side of your body and set the origin. In the figure below, origin is set
such that you are walking in positive x direction.

5. By dragging the black triangles at the bottom, you can set the start and end frame for the analysis and
decrease computation time. Choose the starting frame where the leg of your choice (to track gait cycle)
is nearing heel strike as shown in the figure below. Remember the total number of frames (delta between
frames indicated by the black triangles). You will need to track the markers on the other side of the body for
the same number of frames.

6. Create a point mass to be tracked (for example: right shoulder) by clicking on Create > Point Mass. You
will see a Track Control dialog box pop up. Right click on the mass just created and click on Name and
rename the marker in Set Name dialog box. (This is important as you will be working with 5 markers on
each side of the body.)

7. The goal is to be able to process the marker data in OpenSim. Hence, to make data analysis easier, we
recommend you to name your markers the same way as in OpenSim.



Joint OpenSim Marker Name
Right Shoulder R.Acromium
Right Hip R.ASIS
Right Knee R.Knee.Lat
Right Ankle R.Ankle.Lat
Right Toe R.Toe.Lat

Note: Replace "R" with "L" while naming markers from left side of your body.

8. Click on R.Acromium button and then click the Autotracker button on the toolbar.You should see the Auto-
tracker settings dialog box pop up.

9. Hold Shift+Ctrl an click on the shoulder marker (region of interest) to be tracked.

10. After you have clicked on the region of interest, you will see a square region around your marker. The
smaller this region is the better the tracking will be. Resize the square such that it matches the size of the
marker you have on your shoulder. Make sure the video is set to the starting frame and not the ending
frame in this step. If it is at the end frame, Autotracker will give you an error.

11. In Autotracker settings box, click on Search. You should see your video playing and the point marker moving
along with your physical shoulder marker.

Caution: In case the video was blurry at any instance and Tracker is unable to track the marker you can
either accept the suggestion made by the software or manually click the position where the marker is
located. In either cases, you will need to be very careful where the marker is located. If you accept the
suggestion or manually click a position far away from the actual marker, your data will not be accurate.

12. Repeat steps 6-9 for hip, knee, ankle, and toe markers.

13. On the right side of software window, you will see the data being plotted in real time. This will stop automat-
ically after the video has ended.

14. In the end of the video, you should be able to see all your markers being tracked as shown in the image
below.

15. Copy and paste time, X and Y position data of each marker into an excel file and save. You will need to add
the data of markers from the left side of the body to the same excel file. Note: The time column for all the
markers should be the same (defined by the black triangles). You can delete the time column from the other
4 markers in the excel file.



16. Repeat the steps 3-14 to track markers on the left side of your body.

Important: As you can see in the image above, X distance is going from right to left as you walk whereas X
distance is going from left to right when you are tracking the markers from the right side of your body. When
you copy the data from tracker to your excel file from step 14, multiply X position data from left side of your
body by -1. This will make the coordinates for both sides of your body positive.

17. Save the excel file. You will use the data from this file to create a data file that OpenSim can read.

5 Ground reaction force data
5.1 Digitize the ground reaction force data from the paper

You will need to find grf data (preferrably in all three direction) for the activity you have chosen from literature.
Once you find the paper, take a screenshot of grf plot and save it. You will use WebPlotDigitizer to digitize the
data from the image.

1. You can find the application here.

2. Click on Load image and select the file you saved from the paper.

3. Click on 2D (X-Y) Plot > Align Axes. You will see the following dialog box.

https://apps.automeris.io/wpd/


4. Click on Proceed.

5. Click on two points on X-axis and two points on Y-axis.

6. Click on Complete.

7. Enter the values of the points you clicked on.

8. Click on Assume axes are perfectly aligned with image coordinates (skip rotation correction) and
then OK.

9. Now you can start clicking on the plot. More points will give you more accurate data. After you are satisfied
with the number of points, click on View Data.

10. Copy and paste your data to an excel file. You will be creating a mot file for grf data later on.

6 Data processing

6.1 Creating a trc file for Inverse Kinematics (IK)

1. Now that you have data from all the markers (From 3.17), you will need to create a trc file that OpenSim
will be able to read.

2. Make a copy of the trc file in Box in your local drive and open the file in excel.

Caution: OpenSim can only read a file with a specific format (included in its header). Please make sure to
update the following while creating a trc file.

(a) File name : Update this section by copying your exact filename.

(b) Number of markers : You have a total of 10 markers (from tracker). Make sure to check this number
before saving your trc file.

(c) Number of frames : Opensim checks for the number of data rows and specified frame number in the
file. Make sure to update this number with however many data rows you have.

3. By this step, the header of the trc file should be updated. You will notice that each marker has X, Y, and Z
columns. Tracker only gives you data in 2-D. Copy data for X and Y axes for respective markers from your
excel file into this trc file.



4. In OpenSim, Origin is located between the feet. This means, for medial-lateral movement (Z-axis) one side
(left/right) will be positive and another will be negative. To fill the column for Z-coordinates for hip, measure
the width of your hip and divide it by 2. For example, if the width of your hip is 0.2 m, put 0.1 for all the rows
in R.ASIS hip column and -0.1 for for all the rows in L.ASIS. Use the same idea to fill the Z-coordinates for
all other markers.

5. Save the trc file. Make sure the file you saved has an extension ".trc".

6.2 Create the ground reaction force file

1. Download the ground reaction force file (’.mot’ )from the BOX and open it in Excel. Similar to the ’.trc’ file,
you need to update the headers based on your own data.

2. Update with your own file name and replace ’GRF_test.mot’ in the header with the same name that you
named your file

3. Keep the ’datacolumns’ as 7

4. Update the ’datarows’ to the number of rows of your own ground reaction data.

5. Update the ’range’ based on your own data.

6. Update the ’time’, ’ground_force_vx’ and ’ground_force_vy’ from the excel file that you created by digitizing
data from literature in step 5.1.10.

7. Columns ’px’, ’py’, and ’pz’ will be the contact point for the ground reaction forces. Since you will not be
able to measure it from the experiment, you could use the (x,y,z) position of the closest marker as ’px’, ’py’,
and ’pz’. The choice of the marker depends on your task, and if your task involves shifting of the contact
point, i.e. the contact point moving from the heel to toe, you should measure the length of your foot and
interpolate the contact point at each time point during your task.

8. Whether you use a marker position or you compute the contact point based on your foot length, make sure
’py’ is always 0. The number of data rows in ground reaction force file do not have to be the same, but you
need to make sure both .trc and .mot file have to cover the same time range.

9. You will need to manually discretize the time range to match the number of rows of your force data in the
’.grf’ file.



6.3 Sanity check - data visualization

Visualize your experimental data in OpenSim to ensure the data looks reasonable. After performing experiments,
motion capture data can be previewed in the OpenSim GUI to verify that preprocessing was done correctly and
that data is in agreement with the intended model. If users have multiple files representing different pieces of
data, this tool allows users to synchronize data to verify that the data was transformed consistently. The data
previewer handles two types of data: marker trajectories (contained in .trc files) and measured forces (e.g.,
ground reactions, contained in .mot files).

6.3.1 Visualizing kinematics

1. Select Preview Experimental Data... from the File menu.

2. Browse to select the motion capture data file to be visualized. Once selected, OpenSim performs the
following actions:

a. Adds a new model to the Navigator with the default name of “ExperimentalData” and a unique number,
such as “01”.

b. Makes the loaded motion capture data file the current motion.

3. Use the motion slider in the toolbar to visualize different frames of data. Later, you will synchronize the
motions from different motion files. These other motions could be either motion capture files or results from
OpenSim tools. For example experimentally measured marker trajectories and ground reaction forces can
be synchronized and superimposed on the result of a simulation.

4. In OpenSim, marker trajectories are contained in a .trc file. When loaded with the data previewer, a model
named “ExperimentalData” will contain the loaded motion file consisting of the marker data (e.g. “sub-
ject01_walk1.trc”). The “Markers” node lists each individual marker found in the file. Nodes corresponding
to individual markers have the following options (access options by right clicking the marker name):

a. Show: Enabled only if a marker is hidden

b. Show Only: Hides all other markers except for those selected.

6.3.2 Visualizing ground reaction force and marker data

In OpenSim, external forces (e.g., ground reaction forces) are contained in a .mot file. The header of the selected
force (.mot) file is the same as that expected by OpenSim tools.

The data previewer expects groups of 6 columns for a force of the form “body”_”ForceName”_vx, vy, vz, px,
py, pz, where vi corresponds to each component of the force and pi corresponds to each component of the
location of the force (e.g., center of pressure) and 3 columns for a torque of the form “body”_”TorqueName”_x, y,
z, corresponding to each component of the applied torque. Note that this naming convention is only necessary for
previewing purposes. OpenSim tools employ a new user interface enabling you to specifiy any number of forces,
along with points of application, or torques to a model during any simulation or analysis.

1. Load your ground reaction force data file

2. Note that a new folder has been created

3. While holding the command key, click on the .trc file and the .mot file

4. Right click on your mouse and select sync.motions

5. Now play the motion. Cool!



7 Musculoskeletal modeling

7.1 Scaling

The purpose of this section is to scale the OpenSim model with the measurements of your body segment. For
this project, you will only be scaling your lower body.You will need a measuring tape to measure your lower body
segments.

1. You can either choose the left or the right side of your lower body to take the measurements.

Segment Length to measure
Torso Hip to Shoulder
Hip Left to right Pelvis

Thigh Pelvis to Knee
Shank Knee to Ankle
Foot Ankle to Toe

Using the measuring tape, measure the segment lengths and take notes. Careful : OpenSim’s units are in
meters. Make sure your units match.

2. In OpenSim, open one of the models. Click on Tools>Scale and Scale Tool dialog box will appear.

3. Enter your weight in Subject Data section.

4. You will be manually scaling the segments. To do this, you will be using the segment lengths you measured
and segment lengths calculated from OpenSim. click on Scale Factors tab and you will see the following.

5. In the Navigator window, click on the "+" sign in Markers to expand and see all the markers available in the
model.

6. In OpenSim, X-coordinate is Anterior-Posterior direction, Y-coordinate is Proximal-Distal direction, and Z-
coordinate is Medial-Lateral Direction. Click on the markers to see the coordinates in the Properties win-
dow. Note down the required coordinates. You will need this information to calculate the segment lengths
of the model.

Marker Coordinate
Acromium Y
Asis Y & Z
Knee.Lat Y
Ankle.Lat Y
Heel X
Toe.Lat X

7. Calculate the segment lengths as follows:

Segment Length calculation
Torso Acromium Y_coordinate - Asis Y_coordinate
Pelvis R.Asis Z_coordinate - L.Asis Z_coordinate
Thigh Asis Y_coordinate - Knee Y_coordinate
Shank Knee Y_coordinate - Ankle Y_coordinate
Foot Toe.Lat X_coordinate - Heel X_coordinate

8. Calculate the scale factor using this equation:

Scale factor = OpenSim length/your segment length (1)

You will need to calculate the scale factor for each segment.



9. Now that you have the scale factors for each segment, you can manually scale the segments in OpenSim.
Click on Tools>Scale>Scale Factors.

10. Click on the segment you want to scale and click on "Use manual scales". Enter the scale factor you
calculated in stepX and you will see the table updated.

11. Click on Run after you have manually scaled the segments of your interest.

12. You should see another model appear on the Visualizer Window.

7.2 Inverse kinematics

1. To proceed with Inverse Kinematics procedure, you will need the scaled model with the .trc file. In OpenSim,
after loading the scaled .osim model, click Tools and select Inverse Kinematics. In the dialog window, in
’Marker data for trial’ box, select the .trc file you created. There is NO need to filter the data. Make sure you
select the correct output folder so that you can find your result.

2. In the ’Weighs’ tab, De-select all the items that are ’NOT-FOUND’, and you should be able to see the ’run’
button becomes available.

3. Run the Inverse Kinematics. You can save the IK process by clicking the ’save’ button and save the setting
in a ’.xml’ file.

7.3 Inverse dynamics

Modify GRF file

1. After the Inverse Kinematics, you should obtain a motion file with ’.mot’. Now you will need this motion file
and another motion file that contains ground reaction forces (GRF) data to begin Inverse Dynamics.

2. Before running Inverse Dynamics, manually modify the IK result file by adding ’.mot’ at the end so that it
turns in to the motion file.

3. Now select ’Inverse Dyanmics’ from the ’Tools’ in the input tab, select ’From file’ and select the IK result
motion file.

4. There is no need to filter the IK data. Make sure the time range is correct and select the output folder.

5. In the ’External Loads’ tab, select ’External Loads’ item and click the ‘edit’ button.



6. In the ’External Forces’ tab, load the ’,grf’ file as the force data, and load the IK result for the kinematics
data. There is no need to filter the data.

7. Next, click ’Add’ button on the right and you should see a new window. First, apply the force to the ’calc_r’
by select it in the drop down menu.

8. Select ’Applies Force’ and check’ Point Force’. In the force column, select ’1groundforcevx’ and the next
two should be automatically changed to ’1ground_force_vy’ and ’1_ground_force_vz’.

9. In the Point Columns select ’1_ground_force_px’ and the next two should be automatically changed as well.
Leave the rest as default.



10. Click ’OK’ and save the force setting as a ’.xml’ file. Save the setting of Inverse Dynamics as another ’.xml’
file and click ’RUN’. You should see the results of ID as a ’.sto’ file.

7.4 Static Optimization

1. After completing the Inverse Dynamics, you will need to perform Static Optimization to obtain the muscle
forces.

2. Click ’Tools’ and select ’Static Optimization’, and you should see the window pop up.

3. Select ’Motion’ and ’From file’, here you need to load the ’.mot’ file from the results of Inverse Kinematics.
There is NO need to filter your here. Leave the rest as default and modify the output section as you desired.

4. Now go to ’Actuator and External Loads’ section. Leave the ’Actuators’ section as default. Now click
’External Loads’ and click edit, load the motion and ground reaction force files as you did in the Inverse
Dynamic section.

5. Then you can save the setting as a ’.xml’ file and run the process.

6. The results contains 3 files. One ’activation.sto’ file, one ’controls.xml’ file and one ’force.sto’ file. The
’force.sto’ file contains the force data for the muscle on the model during the activity.

7. You can use the plot tool to plot the muscle forces during the activity.
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